Configurando Android Studio

Introducciodn

Este es el primer post de una pequefia serie sobre Android
Studio. En ellos mostraremos alguna configuraciones,algun
plugin, atajos de teclados y «truquillos».

» NUmero de linea
= Camel humps
» Imports automdticos
= Colores en el logview de Android Studio
= Plugins
= Plugin ButterKnife Zelezny
= Plugin Exynap
 Markdown Navigator

Numeros de linea

Por alguna razén, que no entiendo del todo, por defecto
Android Studio no nos muestra la lineas dentro del editor.


http://adictosalainformatica.com/configurando-android-studio/
http://adictosalainformatica.com/configurando-android-studio/studio-hero/

Para habilitar esta funcionalidad deberemos acceder a
File->Settings ->Editor->General->Appearance y habilitar «Show
line numbers».

Q Editor > General » Appearance

Appearance 8 Behavior
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Keymap
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Camel humps

Android Studio no respeta las palabras ‘camel Humps’ cuando se
navega a través del cédigo con las teclas Ctrl + Izquierda /
Derecha. Para solucionarlo accedemos a
File->Settings->Editor->General->Smart Keys y finalmente
seleccionamos Use ‘Camel Humps’ words


http://adictosalainformatica.com/configurando-android-studio/line_numbers/

Editor > General - Smart Keys

Appearance & Behavior

nentation comment stub

A continuacién, lo que nos ocurrira es que no podremos
seleccionar con doble click una palabra. Para solucionarlo
debemos acceder a File->Settings->Editor->General vy
deseleccionar Honor ‘Camel Humps’ words settings when
selecting on double click


http://adictosalainformatica.com/configurando-android-studio/camel1/

Editor - General

Appearance & Behavior
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placement of caret after end of line' above.

Imports Automaticos

Bien la verdad, es que hoy en dia no es necesario saberse
todos los packages que debemos usar, pues con una combinacidn
de teclas podemos importarlos. Pero, épor que no hacerlo
automaticamente? Para activarlo deberemos acceder a
File->Settings->Editor->General->Auto Import, seguidamente
deberemos seleccionar Optimize imports on the fly y Add
unambiguous imports on the fly


http://adictosalainformatica.com/configurando-android-studio/camel2/

Q Editor > General > Auto Import &

» Appearance 8 Behavior
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Colores en el logview de Android Studio

Bien esto es solo una preferencia. En logcat un buen esquema
de colores nos ayudara a visualizar mejor la informacidn.
Deberemos acceder a File|Settings->Editor->Colors &
Fonts->Android Logcat en este punto debemos hacer clic en Save
As.. y crear un nuevo esquema de colores.


http://adictosalainformatica.com/configurando-android-studio/autoimport/

Seguidamente por cada unos de los tipos de log (Assert, Debug,

Error..) debemos deseleccionar

cada color y aplicar el nuevo.

= Assert: #AA66CC
= Debug: #33B5E5
 Error: #FF4444

= Info: #99CC00

= Verbose: #FFFFFF
= Warning: #FFBB33

Este es el resultado

‘Use inherited attributes’

para


http://adictosalainformatica.com/configurando-android-studio/logcat/
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Code Templates

Plugins

Plugin ButterKnife Zelezny

De este plugin ya he hablado, la verdad es que nos facilita
mucho el uso de Butterknife.Para instalarlo debemos acceder a
File->settings->Plugin, segquidamente clicar en Browse
Repositories buscar ButterKnife Zelezny instalar y reiniciar.
A continuacién os dejo un gif de que muestra su utilizacién,
sacado del proyecto de GitHub de este plugin. También os
animo a que os paséis por la entrada de Butterknife



http://adictosalainformatica.com/configurando-android-studio/logcat_final/
https://github.com/avast/android-butterknife-zelezny
http://adictosalainformatica.com/android-butterknife/

SettingsActivity FragmentActivity {

Config

@0verride

onCreate(Bundle savedInstanceState) {
.onCreate(savedInstanceState)
setContentView(R. layout. )
ButterKnife.inject( )

Intent intent = Intent( GridOverlayService.
startService(intent);

setupViews()

Plugin Exynap

Bien este plugin es espectacular. Nos permite encontrar e
implementar el c6digo que necesitemos en un instante. Para
instalarlo debemos acceder a File->settings->Plugin,
seqguidamente clicar en Browse Repositories buscar Exynap
instalar y reiniciar.

Mediante la combinacidén de teclado Ctrl + Shift + D se abrira
una ventana contextual, des de la cual podremos buscar lo que
necesitamos. 0s dejo algunos gifs de su propia pagina.



Markdown Navigator

Este plugin nos facilitara la edicidén de los archivos de
markdown que tengamos en el proyecto. Por ejemplo ficheros de
Changelog, Readme.. Para 1instalarlo debemos acceder a
File->settings->Plugin, segquidamente clicar en Browse
Repositories buscar Markdown Navigator instalar y reiniciar.

A continuacidén cuando abramos cualquier fichero de markdown se
abrira con el editor instalado.
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AndroKeePass (under development)

KeePass 2.x database files

Libraries used on this project

License

Observaciones

Bien, este post no ha sido de programacién propiamente dicha.
Ha sido una preconfiguracion de Android Studio. La verdad es
que estas pequenas configuraciones y plugins nos ayudan a
programar de manera mas optima y rdapida. En el siguiente post
mostraremos atajos de teclado de Android Studio (que son
varios y muy uGtiles).

it 2.0

ST Client for A

Android - Retrofit y


http://adictosalainformatica.com/configurando-android-studio/markdown/
http://adictosalainformatica.com/android-retrofit-seeeduino-cloud/

Seeeduino Cloud

Retrofit 2.0

A type safe REST Client for Android & Java

android — retrofit

Introduccidn

Y con este post 1llegamos a una de la librerias mas utiles.
Retrofit nos facilita el uso de llamadas rest, realizando las
1lamadas asincronas sin que nosotros nos preocupemos de nada.
Si ademas usamos GSON podemos obtener el resultado en una
colecciéon de objetos. La utilizacién de Retrofit en nuestros
proyectos es muy facil y ofrece un buen rendimiento. Una vez
mas, Square nos brinda una gran libreria (ya hemos hablado
anteriormente de Picasso).

Este post es una continuacién de los de seeeduino (Seeduino
Cloud — Parte 1 , Seeeduino Cloud — Parte 2). Al finalizarlo
podremos controlar nuestro ventilador des de una aplicaciodn
Android.

» Creando la estructura del proyecto
= Configuracion

= Creando nuestras clases Pojo

= Creando una instancia de Retrofit
 Preparando end points

= Preparando nuestro activity


http://adictosalainformatica.com/android-retrofit-seeeduino-cloud/
http://adictosalainformatica.com/android-retrofit-seeeduino-cloud/retrofit/
http://adictosalainformatica.com/?p=1117

Creando el proyecto y su estructura

Crearemos un proyecto con un empty activity

Create New Project x

H} Add an Activity to Mobile

A continuacidén crearemos una nueva estructura de packages.
Esto es una costumbre, no es ningun estandar y cada
developer utiliza la que mds le conviene o resulta mds facil
de usar, para organizar su cédigo. Muy probablemente, cambiara
durante el proceso desarrollo y aqui cada unos tiene sus
preferencias. Lo que realmente es importante es utilizar una
que nos ayude mantener nuestro codigo debidamente organizado.


http://adictosalainformatica.com/android-retrofit-seeeduino-cloud/android_new_project/
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Configuracion

Anadiremos el plugin android-apt a nuestro classpath en el
fichero build.gradle. Este se encuentra en la raiz de nuestro
proyecto.

dependencies{
classpath 'com.neenbedankt.gradle.plugins:android-apt:1.8"

}

Dentro del archivo app/build.gradle, debemos afiadir 1las
dependencias de Retrofit.

apply plugin : 'com.neenbedankt.android-apt'
dependencies {

// retrofit, gson

compile 'com.google.code.gson:gson:2.6.2"

compile 'com.squareup.retrofit2:retrofit:2.0.2"
compile 'com.squareup.retrofit2:converter-gson:2.0.2"


http://adictosalainformatica.com/android-retrofit-seeeduino-cloud/package_structure/

// picasso
compile 'com.squareup.picasso:picasso:2.5.2'
compile 'jp.wasabeef:picasso-transformations:2.1.0'

// butterknife
compile 'com.jakewharton:butterknife:8.4.0°'
apt 'com.jakewharton:butterknife-compiler:8.4.0'

}

Seguidamente afiadiremos el permiso de red y de comprobacidn de
esta a nuestro archivo androidmanifest.xml

<uses-permission android:name="android.permission.INTERNET"/>
<uses-permission
android:name="android.permission.ACCESS NETWORK STATE"></uses-
permission>

Creando nuestra clase Pojo

Esta es la clase base sobre la que Gson creara la instancia
con los resultados de la llamada rest realizada con Retrofit,
colocaremos la clase en el package model. Una de las maneras
mas faciles de generar nuestras clases es utilizar un
generador. Por ejemplo, jsonschema2pojo. Pero debemos tener
cuidado, podemos encontrarnos facilmente con una respuesta
Json 1inmensa de 1la cual tan solo necesitamos alguna
informacidén concreta.

package com.adictosalainformatica.fanmanager.model;

import com.google.gson.annotations.Expose;
import com.google.gson.annotations.SerializedName;

public class FanModel {

@SerializedName("pin")
@Expose

private Integer pin;
@SerializedName("status")
@Expose


http://www.jsonschema2pojo.org/

private Integer status;

/**
*
* @return
* The pin
*/
public Integer getPin() {
return pin;

}

/**
*
* @param pin
* The pin
*/
public void setPin(Integer pin) {
this.pin = pin;

}

/**
b3
* @return
* The status
*/
public Integer getStatus() {
return status;

}

/**
>k
* @param status
* The status
*/
public void setStatus(Integer status) {
this.status = status;

}

Es importante no acabar con una coleccidén de clases inmensa



Llena de getters y setters que no vamos a utilizar. Todo ello
para mantener nuestro coédigo limpio o no acabar encontrandonos
el error «64k method limit in dex». No es raro encontrarnos
con él si utilizamos muchas librerias y colecciones de clases
generadas a partir del resultado de una respuesta Json
desmesurada. Podemos facilmente solventar el problema
revisando nuestras clases Pojo y eliminando todas aquellas
variables y clases que no vamos a utilizar e incluso
plantearnos si todas las librerias que estamos utilizando son
realmente necesarias. Pero si esto no fuera suficiente,
podemos solventar el problema con multidex a costa de perder
la funcionalidad de instant run.

Creando una instancia de Retrofit

Para enviar solicitudes de red a una API, tenemos que utilizar
la clase Retrofit.Builder y especificar la URL base para el
servicio. Por 1lo tanto, crearemos una clase llamada
ApiClient.java bajo en el package rest.

BASE URL — es la url base de nuestra API. Vamos a utilizar
esta url para todas las solicitudes posteriores.

package com.adictosalainformatica.fanmanager.rest;

import retrofit2.Retrofit;
import retrofit2.converter.gson.GsonConverterFactory;

public class ApiClient {
public static final String BASE URL =

"http://192.168.1.33/arduino/";
private static Retrofit retrofit = null;

public static Retrofit getClient() {
if (retrofit==null) {


https://developer.android.com/studio/build/multidex.html
http://tools.android.com/tech-docs/instant-run

retrofit = new Retrofit.Builder()
.baseUrl(BASE URL)
.addConverterFactory(GsonConverterFactory.create())
Lbuild();

}

return retrofit;

Preparando end points

Los end points se definen dentro de una interfaz mediante
anotaciones especiales de Retrofit para codificar informacidn
sobre los parametros y el tipo de peticidén. Ademds, el valor
de retorno es siempre una llamada con parametros <T>, en
nuestro caso <FanModel>. Crearemos 1la interface
ApiInterface.java en el package rest

package com.adictosalainformatica.fanmanager.rest;

import
com.emotionexperience. fragancemanager.model.FraganceModel;

import retrofit2.Call;
import retrofit2.http.GET;
import retrofit2.http.Path;

public interface Apilnterface {
@GET("digital/{pin}/{value}")
Call setPin(@Path("pin") int pin, @Path("value") int
value);

@GET("status/{pin}")
Call getStatus(@Path("pin") int pin);



Preparando nuestro activity

A continuacidén mostramos el coédigo de nuestro activity que se
encuentra en el package ui. Como se puede observar utilizamos
Picasso y Butterknife

package com.adictosalainformatica.fanmanager.ui;

import
import
import
import
import
import
import
import
import

import
import
import
import
import

import
import
import

android.
android.

android

android
android

app.ProgressDialog;
content.Context;

.graphics.Color;
android.
android.
android.
android.
.widget.ImageButton;
.widget.Toast;

net.ConnectivityManager;
0s.Bundle;
support.v7.app.AppCompatActivity;
util.Log;

com.adictosalainformatica.fanmanager.R;
com.adictosalainformatica. fanmanager.model.FanModel;
com.adictosalainformatica.fanmanager.rest.ApiClient;
com.adictosalainformatica.fanmanager.rest.Apilnterface;
com.squareup.picasso.Picasso;

butterknife.BindView;
butterknife.ButterKnife;
butterknife.OnClick;

import
jp.wasabeef.picasso.transformations.ColorFilterTransformation;
import
jp.wasabeef.picasso.transformations.CropCircleTransformation;
import retrofit2.Call;

import retrofit2.Callback;

import retrofit2.Response;

public class MainActivity extends AppCompatActivity {

@BindView(R.id.main btn fan)
ImageButton btnFan;

// Constants


http://adictosalainformatica.com/?p=1117
http://adictosalainformatica.com/?p=1139

private static final String TAG =
MainActivity.class.getName();
private static int PIN = 8§;

private int fanStatus = 0;
private static Apilnterface apiService;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity main);

ButterKnife.bind(this);

Picasso
.with(getApplicationContext())
.load(R.drawable.fan image)
.transform(new CropCircleTransformation())

.into(btnFan);

apiService
ApiClient.getClient().create(ApiInterface.class);

if(isConetctionEnabled(getApplicationContext())){
getFanStatus(PIN);
telse{
Toast.makeText(getApplicationContext(),"Internet
connection failed",Toast.LENGTH LONG).show();
}
}

@OnClick(R.id.main btn fan)
public void switchFanStatus() {
if(isConetctionEnabled(getApplicationContext())){

if(fanStatus == 0){
setFanStatus (PIN,1);
telse{

setFanStatus(PIN, 0);

}
telse{



Toast.makeText(getApplicationContext(),“"Internet
connection failed",Toast.LENGTH LONG).show();

}
}

/**
* Get current Fan status
* @param pin
*/
private void getFanStatus(int pin) {
Call <FanModel> call = apiService.getStatus(pin);
call.enqueue(new Callback<FanModel>() {
@Override
public void onResponse(Call<FanModel> call,
Response<FanModel> response) {
if (response.isSuccessful()) {
fanStatus = response.body().getStatus();
Log.d(TAG, "Fan status: " + fanStatus);

if(fanStatus == 0){

int color
Color.parseColor("#33ee092b");
setColorFilter(color);

}else{
int color =
Color.parseColor("#3300ff80");
setColorFilter(color);

}
} else {
//request not successful (like 400,401,403
etc)
Log.e(TAG, response.message());
}
}
@Override

public void onFailure(Call<FanModel> call,
Throwable t) {
// Log error here since request failed
Log.e(TAG, "Error: " + t.toString());



/**
* Set Fan status
* @param pin
*/
private void setFanStatus(int pin, int status){
Call call = apiService.setPin(pin,status);
call.enqueue(new Callback<FanModel>() {
@Override
public void onResponse(Call<FanModel> call,
Response<FanModel> response) {
if (response.isSuccessful()) {
fanStatus = response.body().getStatus();
Log.d(TAG, "Fan status: " + fanStatus);

if(fanStatus == 0){

int color
Color.parseColor("#33ee092b");
setColorFilter(color);

}else{

int color
Color.parseColor("#3300ff80");
setColorFilter(color);

}
} else {
//request not successful (like 400,401,403
etc);
Log.e(TAG, response.message());
}
}
@Override

public void onFailure(Call<FanModel> call,
Throwable t) {
// Log error here since request failed
Log.e(TAG, "Error: " + t.toString());



/**
* Set image filter color
* @param color
*/
private void setColorFilter(int color){
Picasso
.with(getApplicationContext())
.load(R.drawable. fan image)
.transform(new
ColorFilterTransformation(color))
.transform(new CropCircleTransformation())
.into(btnFan);

}

/**
* Tests if there's connection
* @param cx context application
* @return true or false
*/
public static boolean isConetctionEnabled(Context cx){
ConnectivityManager conMgr =
(ConnectivityManager)cx.getSystemService(Context.CONNECTIVITY
SERVICE);

if (conMgr.getActiveNetworkInfo() != null
&& conMgr.getActiveNetworkInfo().isAvailable()
&&

conMgr.getActiveNetworkInfo().isConnected()) {
return true;
} else {
return false;

}
}
I finalmente, nuestro layout

<?xml version="1.0" encoding="utf-8"7?>
<RelativelLayout



xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:app="http://schemas.android.com/apk/res-auto"
xmlns:tools="http://schemas.android.com/tools"
android:id="@+id/activity main"
android:layout width="match parent"
android:layout height="match parent"
android:paddingBottom="@dimen/activity vertical margin"
android:paddingLeft="@dimen/activity horizontal margin"
android:paddingRight="@dimen/activity horizontal margin"
android:paddingTop="@dimen/activity vertical margin"
tools:context="com.adictosalainformatica.fanmanager.ui.MainAct
ivity">

<ImageButton

android: layout width="wrap content"
android:layout height="wrap content"
app:srcCompat="@drawable/fan image"
android:layout centerVertical="true"
android: layout centerHorizontal="true"
android:id="@+id/main btn fan"
android:background="@null"
android:padding="10dp"/>

</RelativelLayout>

Desde este enlace os podéis descargar fan image

Observaciones

Después de mucho tiempo lidiando con AsyncTask, rotaciones,
memory leaks.. Retrofit nos permite abstraernos de todo esto y
ademds es muy facil de utilizar. Por todo ello, Retrofit se
convierte en una libreria casi indispensable. Finalmente, dejo
el enlace a la web de Retrofit y un ejemplo en Github. ELl
cual, nos permite apagar y encender un ventilador siempre y
cuando tengamos nuestro Seeduino Cloud configurado y preparado
para trabajar con un relayshield.

= Retrofit
= Seeeduino Cloud — Parte 1 (configuracion Seeduino Cloud)
» Seeeduino Cloud — Parte 2 (Montaje relayshield)



http://adictosalainformatica.com/wp-content/uploads/2016/09/fan_image.jpeg
http://square.github.io/retrofit/
http://adictosalainformatica.com/seeeduino-cloud-parte-1/
http://adictosalainformatica.com/seeeduino-cloud-parte-2/

= FanManager

Seeeduino Cloud — Parte 2

Seeeduino Cloud

Introduccidn

En este post afadiremos una relay shield a nuestro seeeduino.
Seguidamente, realizaremos el cableado con uno de los relay y
conectaremos un pequeio ventilador. De esta manera podremos
encender y apagar nuestro ventilador remotamente.

 Montando el Relay Shield y cableado de un relay
 Programa para controlar el relay
 Encendiendo y apagando nuestro ventilador


https://github.com/rmiguel1985/FanManager
http://adictosalainformatica.com/seeeduino-cloud-parte-2/
http://adictosalainformatica.com/seeeduino-cloud-parte-1/seeeduinocloud/

Montando el Relay Shield y cableando un relay

EL funcionamiento de un relay es bastante simple. Un relay es
un switch electromagnético. Un relay tiene tres entradas:

nc (normally closed). El circuito tiene corriente, a no
ser que se active el relay.

=no (normally open). El circuito no tiene corriente, a no
ser que se active el relay.

com (entrada de electricidad). Punto de entrada del
corriente eléctrico externo.

En el siguiente ejemplo podemos ver la conexion de un relay
con un motor. Si observamos el diagrama el motor no estara en
funcionamiento hasta que se active el relay.

13

M3

COoM3

(0

+ -
External Power
(e.g. battery, power supply)

Motor-shield-schematic-drawing

Primeramente montaremos la relay shield encima de nuestro
Seeeduino (Encaja perfectamente).

Seguidamente cablearemos un relay. En este ejemplo
utilizaremos el relay 3 (digital pin 8), pero se podria
utilizar cualquiera. La entrada de corriente estara en el
conector C

, ¥ la salida en el conector NO


http://adictosalainformatica.com/seeeduino-cloud-parte-2/motor-shield-schematic-drawing/
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Seguidamente la embra:

Y finalmente la toma de electricidad:


http://adictosalainformatica.com/seeeduino-cloud-parte-2/a000110-arduino-4-relays-shield-1front/
http://adictosalainformatica.com/seeeduino-cloud-parte-2/photo21304283784914997/
http://adictosalainformatica.com/seeeduino-cloud-parte-2/photo21304283784914998/

Solo nos quedara conectar el macho a la corriente y un
ventilador a la hembra.

Para mas informacidén sobre el relay shield utilizado os dejo
el link de la pagina del mismo Arduino — 4 Relays Shield

Programa para controlar el relay

A continuacién este es el programa que permitira acceder
remotamente a nuestro relay. El cddigo esta debidamente
comentado

#include <Bridge.h>


http://adictosalainformatica.com/seeeduino-cloud-parte-2/photo21304283784914999/
http://www.arduino.org/products/shields/arduino-4-relays-shield

#include <BridgeServer.h>
#include <BridgeClient.h>

// Listen to the default port 5555, the Yun webserver
// will forward there all the HTTP requests you send
BridgeServer server;

int RELAY3 = 8§;

void setup() {
// Bridge startup
pinMode (13, OUTPUT);
digitalWrite(13, LOW);
Bridge.begin();
digitalWrite(13, HIGH);
pinMode (RELAY3, OUTPUT);

// Listen for incoming connection only from localhost
// (no one from the external network could connect)
server.listenOnLocalhost();

server.begin();

}

void loop() {
// Get clients coming from server
BridgeClient client = server.accept();

// There is a new client?
if (client) {
// Process request
process(client);

// Close connection and free resources.
client.stop();

}

delay(50); // Poll every 50ms
}

void process(BridgeClient client) {
// read the command



String command = client.readStringUntil('/");

// 1s "digital" command?
if (command == "digital") {
digitalCommand(client);

}

// 1s "status" command?
if (command == "status") {
statusCommand(client);
}
}

void digitalCommand(BridgeClient client) {
int pin, value;

// Read pin number
pin = client.parselnt();

// If the next character is a '/' it means we have an URL
// with a value like: "/digital/13/1"
if (client.read() == "'/') {
value = client.parselnt();
digitalWrite(pin, value);
} else {
value = digitalRead(pin);
}

// Send feedback to client
client.print(F("{\"pin\":"));
client.print(pin);
client.print(F(" ,\"status\":"));
client.print(value);
client.print(F("}"));

o~ o~ o~ o~

// Update datastore key with the current pin value
String key = "D";

key += pin;

Bridge.put(key, String(value));



void statusCommand(BridgeClient client) {
int pin, value;

// Read pin number
pin = client.parselInt();
value = digitalRead(pin);

// Send feedback to client
client.print(F("{\"pin\":"));
client.print(pin);
client.print(F(" ,\"status\":"));
client.print(value);
client.print(F("}"));

Encendiendo y apagando nuestro ventilador

Desde un navegador accediendo a la url obtendremos el estado
del relay:

http://ip-seeduino/arduino/status/8
{"pin":8 ,"status":0}

Retornara un 0 (apagado) o 1 (encendido)
Para apagarlo
http://ip-seeeduino/arduino/digital/8/0
{"pin":8 ,"status":0}

Y para encenderlo

http://ip-seeeduino/arduino/digital/8/1

{"pin":8 ,"status":1}

Conclusidn

Ya podemos controlar nuestro ventilador remotamente y como



podemos ver ha resultado muy fdcil. Pero la verdad, con una
url desde el plugin de un navegador es muy rudimentario y no
excesivamente Util. En el préximo post crearemos una simple
aplicacién Android, que se encargara de controlar y obtener el
estado de nuestro ventilador des de la Rest Api de Seeeduino.
De paso presentaremos y utilizaremos una libreria muy (til
para este tipo de escenarios, Retrofit. A continucacidn podéis
encontrar el ejemplo del cdédigo arduino en GitHub y el enlace
a la placa de rayls de arduino.

= Arduino 4 Relay Shield
= Seeeduino Rest Api example

Seeeduino Cloud — Parte 1

Introduccion

Recientemente he adquirido un Seeeduino Cloud. Un clon


http://www.arduino.org/products/shields/arduino-4-relays-shield
https://github.com/rmiguel1985/SeeeduinoRestApi
http://adictosalainformatica.com/seeeduino-cloud-parte-1/
http://adictosalainformatica.com/?attachment_id=1178

compatible con Yun. La verdad es que es muy versatil, facil de
configurar y potente. En este primer post hablaremos un poco
de él, lo configuraremos y habilitaremos su Api Rest para
encender y apagar el led que incorpora la placa.

= Configuracioén de red
= Configuracidén con WebGui
» Programa de ejemplo y test

Configuracion de red

Cuando arranquemos por primera vez nuestro Seeeduino, este
levantard una wifi 1lamada SeeeduinoCloud-AXXXX a la que nos
podremos conectar. Una vez echo esto, podremos acceder a la
configuracién web a través de la ip 192.168.240.1.

Welcome to your Seeeduino Cloud. Please enter password to access the web control panel

SEEEDUINO

CLOUD

PASSWORD

E1l password por defecto es seeeduino.

Configuracion con WebGui

Después de entrar en la web, la interfaz nos mostrara el
estatus de las redes WiFi/ Eth. En la parte superior derecha
encontraremos las siguientes opciones:

= SYSTEM -> Configuracion global
= SENSORS -> configuracidn del servidor IoT


http://adictosalainformatica.com/?attachment_id=1195

» UPGRADE -> Actualizacidén de firmware

WELCOME TO SEEEDUINO CLOUD STy

SENSORS

SEEEDUINO

CLOUD

UPGRADE

Seleccionaremos SYSTEM y configuraremos nuestro Seeeduino
Cloud:

 Primeramente podemos modificar el password de acceso

= A continuacidén seleccionaremos la red wifi a 1la que
qgueremos conectar nuestro Seeeduino Cloud vy
estableceremos el password de la misma

 Finalmente, podemos proteger nuestra red con una
password para la Api Rest. Si lo hacemos debemos tener
en cuenta que sera una proteccidén Basic Atuh y el
usuario por defecto serd root


http://adictosalainformatica.com/?attachment_id=1196

For more advanced network canfiguration features, see the advanced configuration panel

(luci)

SEEEDUINO

c Lo U D CLOUD CONFIGURATION

SEEEDUING CLOUD NAME * | Seeed

PASSWORD

CONFIRM PASSWORD

TIMEZONE ¥ |Rest of the Waorld (UTC)

WIRELESS PARAMETERS

CONFIGURE A WIRELESS NETWORK @

I DETECTED WIRELESS NETWORKS |Select a wifi network. ..

WIRELESS NAME * | |

secuRITY

CONFIGURE & RESTART

REST API ACCESS

IREI'APIM'_E @ OPEN O WITH PASSWORD

REST APIs allow you to access your sketch from the web,

sending commands or exchanging configuration values.

If your ¥Yun is on a public network, or controlling sensitive
equipment, or both, we recommend you leave the REST API
password protected.

Cuando pulsemos en CONFIGURE & RESTART nuestro Seeeduino se
configurara, se reiniciard y se conectara a nuestra red.

Programa de ejemplo y test

Bien lo siguiente sera subir un cdédigo de ejemplo al Arduino
para poder testear la aplicacién. Para mas informacién sobre


http://adictosalainformatica.com/?attachment_id=1197

como subir un programa des del IDE a nuestro Arduino podéis

mirar este post Arduino — Primera Parte.
ejemplo de la libreria Bridge.

Utilizaremos un

€9 sketch_jun29a Arduine 1.6.9
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Una vez subido nuestro programa atacaremos la Api Rest para
encender y apagar el led que vine incorporado en la placa,
exactamente el 13 (situado justo detrds del puerto microusb).
En esta caso utilizo el plugin para Firefox RESTclient, aunque
podriamos utilizar cualquier otro. En la url especificamos la

ip de nuestro Seeeduino,

arduino(podemos acceder a otros


http://adictosalainformatica.com/?p=367
http://adictosalainformatica.com/?attachment_id=1200
https://addons.mozilla.org/ca/firefox/addon/restclient/

elementos de la placa), el tipo de pin (en este caso digital),
el pin (13) y el valor (0 apagado, 1 encendido). La url final
seria http://192.168.1.36/arduino/digital/13/1 (encendido) o

http://192.168.1.36/arduino/digital/13/0 (apagado)

Method | GET v URL | http://192.168.1.36/arduino/digital/13/1 wov m

Body

Uy Response Body (Highlight) Response Body (Preview)

Responze Headerz !

Pin D13 set to 1

Conclusion

Como podemos ver la potencia de Seeeduino Cloud es mucha.
Facilmente podemos acceder a nuestro Arduino recibiendo vy
enviando valores a través de una sencilla Rest Api. En el
proximo post acoplaremos un Relay Shield, esto nos permitira
controlar remotamente aparatos electrénicos (dado el calor que
hace ahora, un pequeino ventilador)



http://adictosalainformatica.com/?attachment_id=1202

Introduccidn

En este post trataremos con una libreria muy atil. En este
caso nos ayuda deshacernos de mucho cdédigo. De esta manera
nuestra aplicacion nos queda mucha mas limpia y legible. Lo
mejor de todo es que esta libreria inyecta cédigo en tiempo de
compilacidn, es decir, el rendimiento de nuestra aplicacién no
se vera afectado por su uso.

= Configuracidn

 Ejemplo de uso con Activity
 Ejemplo de uso con Fragment
= Eventos

» Usando Resources

= Plugin ButterKnife Zelezny


http://adictosalainformatica.com/android-butterknife/
http://adictosalainformatica.com/wp-content/uploads/2016/06/8QU88W8.png

Configuracion

Para la instalacién, tenemos que anadir el plugin android-apt
a nuestro classpath en el fichero build.gradle. Este se
encuentra en la raiz de nuestro proyecto.

dependencies{
classpath 'com.neenbedankt.gradle.plugins:android-apt:1.8"

}

Dentro del archivo app/build.gradle, debemos afiadir el plugin
antes de afnadir las dependencias de Butterknife.

apply plugin : 'com.neenbedankt.android-apt'

dependencies {
compile 'com.jakewharton:butterknife:8.0.1"°
apt 'com.jakewharton:butterknife-compiler:8.0.1"

}

Ejemplo de uso
Eliminaremos el uso de findViewById utilizando @BindView en
los views de Android (TextView, Button, EditText..):

class MainActivity extends Activity {
// Automatically finds each field by the specified ID.
@BindView(R.id.title) TextView title;
@BindView(R.id.name) EditText name;
@BindView(R.id.btn send name) Button sendName;

@Override public void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.main activity);
ButterKnife.bind(this);

// Some code

}

}

Como podemos ver se simplifica el cdédigo y a su vez se hace



mas legible.

Ejemplo de uso con Fragment

Cuando utilicemos fragments tendremos que especificar en el
método bind la vista con la que vamos a trabajar y en el
evento onDestroyView utilizar unbind:

public class SimpleFragment extends Fragment {
@BindView(R.id.txt name) Button name;
@BindView(R.id.btn send name) Button sendName;

@Override public View onCreateView(LayoutInflater inflater,
ViewGroup container, Bundle savedInstanceState) {
View view = inflater.inflate(R.layout.simple fragment,
container, false);
ButterkKnife.bind(this, view);
// Some code
return view;

}

// When binding a fragment in onCreateView, set the views to
null in onDestroyView.

// Butter Knife has an unbind method to do this
automatically.

@Override public void onDestroyView() {

super.onDestroyView();
ButterKnife.unbind(this);

}

}

Eventos
Los eventos seran funciones con la anotacidn correspondiente.

@OnClick(R.id.submit)
public void sayHi(Button button) {
button.setText("Hello!");

}



También podemos agrupar vistas y asignarlas a un Unico evento

@OnClick({R.id.maint btn change text,
R.id.main btn new intent})
void buttonClick(View v) {
switch (v.getId()){
case R.id.maint btn change text:
title.setText(name.getText().toString());
break;
case R.id.main btn new intent:
Intent resourcesIntent = new Intent(this,
ResourcesActivity.class);
startActivity(resourcesIntent);
break;

}

Podremos wutilizar 1los siguientes eventos: OnClick,
OnLongClick, OnEditorAction, OnFocusChange, OnItemClick,
OnItemLongClick,OnItemSelected, OnPageChange, OnTextChanged,
OnTouch, OnCheckedChanged.

Usando resources
Podemos hacer binding de resources facilmente

@BindString(R.string.title) String title;
@BindDrawable(R.drawable.my drawable) Drawable myDrawable;
@BindColor(R.color.red) int red;

Plugin ButterKnife Zelezny
Este es un plugin para Android Studio muy Gtil. A partir de
una vista nos genera todos los bindviews para esta.

Primeramente deberemos instalar el plugin en Android Studio:

- Des de Android Studio: iremos a File -> Settings ->
Plugins -> Browse repositories y buscaremos ButterKnife
Zelezny



. Descargandolo: decargamos el plugin ButterKnife
Zelezny y lo instalamos des de File -> Settings ->
Plugins -> Install plugin from disk

Para hacer uso del plugin debemos incluir Butterknife tal vy
como hemos mostrado al principio del post. Finalmente, os dejo
un gif sacado de la pdagina del proyecto de GitHub donde se
muestra su utilizacion.

SettingsActivity FragmentActivity {

ConfTig

@0verride

onCreate(Bundle savedInstanceState) {
onCreate(savedInstanceState)
setContentView(R. layout. )
ButterKnife.inject( )

Intent intent = Intent( GridOverlayService.
startService(intent);

setupViews()

Como nota final, decir que se generan los nombres de las
variables a partir de los ids asignados a las vistas del
layout seleccionado. Es decir, main_btn_show_toast se
convertird en mainBtnShowToast. En el cuadro de dialogo
podremos modificar esos nombres, uno a uno claro. Si


http://plugins.jetbrains.com/plugin/7369
http://plugins.jetbrains.com/plugin/7369
https://github.com/avast/android-butterknife-zelezny

observamos atentamente un correcto «naming» en nuestro layout
nos generara automaticamente variables con un «naming»
adecuado. El problema es que nos encontramos con la anotacidn
correspondiente al layout, mainBtnShowToast. Solucionar esto
es facil, «cogeremos como ejemplo 1las variables
correspondientes a los Buttons del layout main:

»Seleccionamos el layout y 1la primera letra
correspondiente a la vista que queremos modificar

=Seguidamente con atajo de teclado alt + j
seleccionaremos todas la variables correspondientes al
layout y la inicial de la vista a modificar

Y finalmente, corregimos el nombre para todas las
variables

Observaciones

Butterknife nos ofrece una manera de mantener nuestro coédigo
limpio y 1legible. Algo que a largo plazo se hace
indispensable, pues cualquier software se va a tener que
mantener. Y que nuestro cédigo sea limpio y legible es vital
para esta tarea. Hemos mostrado también un plugin muy uUtil
para utilizar la libreria y al final hemos hablado un poco de
naming. Esto daria para otro post y llegara. Por otro lado
también hemos mostrado un atajo de teclado de Android Studio,
los atajos de teclado para Android Studio dan para otro futuro
post y asi podriamos seguir y no parar nunca. Finalmente, dejo


http://adictosalainformatica.com/android-butterknife/butter1/
http://adictosalainformatica.com/android-butterknife/butter2/
http://adictosalainformatica.com/android-butterknife/butter3/

el enlace a la web de Butterknife (donde podréis encontrar
ejemplos mas avanzados), el enlace a la cuenta de GitHub del
plugin ButterKnife Zelezny y un simple ejemplo en Github (el
proyecto de Picasso refactorizado usando Butterknife).

= Butterknife
= ButterkKnife Zelezny
= ButterKnifeTest

Android — Picasso

Introduccidn

Seguimos con una de esas librerias que nos solucionan de
manera espectacular la utilizacidén de imagenes en nuestros
proyectos, Picasso. Existen otras como Glide (recomendada por
Google) o Fresco (Facebook). Las diferencias entre Picasso y
Glide son pocas, en cuanto a Fresco se refiere, es una
aproximacién diferente al tratamiento de imdgenes en android.
En este post (nearsoft) podeis ver una breve comparacidén entre



http://jakewharton.github.io/butterknife/
https://github.com/avast/android-butterknife-zelezny
https://github.com/rmiguel1985/ButterKnifeTest
http://adictosalainformatica.com/android-picasso/
http://adictosalainformatica.com/wp-content/uploads/2016/06/picasso.png
http://nearsoft.com/blog/image-libraries-for-busy-android-developers/

la tres y en este otro post (inthecheesefactory blog)

encontraras una comparacién entre Glide y Picasso. Bien, vamos
con Picasso:

» Configuracion y utilizacidn

= Picasso con assets o drawables
» Resize ,fit y rotation

= Scaling

= Placeholder y error

» Picasso Transformation Library
» Cache Indicators y Logging

= Observaciones

Configuracion y utilizaciodn

Dentro del archivo app/build.gradle, debemos afadir la
dependencia de Picasso.

dependencies{
compile 'com.squareup.picasso:picasso:2.5.2'

}

Una vez afladida podemos empezar a utilizarla, como podéis ver
es muy simple:

ImageView ourImageView = (ImageView)
findViewById(R.id.1imageView) ;
String remoteUrl =

"http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg";
Picasso
.with(this)

. load(remoteUrl)
.into(ourImageView);

Picasso con assets, drawables o ficheros guardados

Realmente facil:


https://inthecheesefactory.com/blog/get-to-know-glide-recommended-by-google/en

// Loading drawable
Picasso
.with(this)
.load(R.drawable.image)
.into(imageViewl);

// Loading asset

Picasso
.with(this)
.load("file:///android asset/image.png")
.into(imageView2);

// Loading file from storage
File file = new
File(Environment.getExternalStoragePublicDirectory(Environment
.DIRECTORY PICTURES), "Android.png");
Picasso

.with(this)

.load(file)

.into(imageView3);

Resize, fit y rotation
Podemos redimensionar la imagen.

Picasso

.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
II)

.resize(100, 100)

.into(imageView);

Pero en caso de que la imagen sea mas pequeia tenemos la
opcidén de evitar este reescalado. Redimensionar una imagen
haciéndola mas grande nos supone un uso de recursos que muchas
veces nos va a dar un resultado muy pobre. En este caso
podemos utilizar scaleDown(true), de esta manera la imagen se
redimensionara si el resultado final implica unas dimensiones
inferiores a las originales.



Picasso

.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.resize(100, 100)

.scaleDown ()

.into(imageView) ;

0 bien hacer que se redimensione automaticamente al tamafo del
imageView. Esto puede hacer que la carga de la imagen tarde un
poco mas, puesto que primero se debe esperar a poder obtener
el tamaho del imageView.

Picasso.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
II)

LFit()

.into(imageView) ;

Podemos rotar la imagen

Picasso.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
II)

.rotate(180f)

.into(imageView) ;

E incluso indicar que punto queremos utilizar para pivotar la
rotacién

// rotate(float degrees, float pivotX, float pivotY)
Picasso

.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.rotate(45f, 200f, 100f)

.into(imageViewComplexRotate);

Scaling

El reescalado de imdgenes puede afectar el aspect ratio y



hacer que esta se vea deforme. Para solucionar esto podemos
utilizar centerCrop() o centerInside().

CenterCrop

Se escala la imagen haciendo que coincida con los limites del
ImageView y entonces se elimina la parte restante de 1la
imagen. El ImageView contendra la imagen pero seguramente se
perderan partes de esta.

Picasso

.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.resize(100, 100) // resizes the image to these dimensions
(in pixel)

.centerCrop()

.into(imageViewResizeCenterCrop);

CenterInside

Se escala la imagen teniendo en cuenta que las dos
dimensiones de la imagen son iguales o inferiores al tamano
del imageView. La imagen se mostrara completa pero puede que
no ocupe todo el imageView.

Picasso

.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.resize(100, 100)

.centerInside()

.into(imageViewResizeCenterInside);

Placeholder y error

Podemos utilizar una imagen temporal hasta que nuestra imagen
se haya cargado y otra en caso de que ocurra un error. De esta
manera, el usuario tendra la sensacidn que durante un tiempo
de espera o incluso un error la aplicacién funciona
perfectamente.



Picasso.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
II)

.placeholder(R.drawable.placeholder image)

.error(R.drawable.error _image)

.into(imageView) ;

Picasso Transformation Library

Existe una libreria que nos permite hacer transformaciones a
nivel avanzado y de manera muy facil picasso-transformations.
0s recomiendo que paséis por su cuenta de Github puesto que
aqui solo mostraremos dos ejemplos.

Primeramente en el archivo app/build.gradle, debemos afiadir la
dependencia de picasso-transformations.

dependencies{
compile 'jp.wasabeef:picasso-transformations:2.1.0'

}

Una vez afadida podemos empezar a tulizarla, por ejemplo para
aplicar un crop circular:

Picasso
.with(this)

.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
II)
.transform(new CropCircleTransformation())
.into(imageView) ;

También podemos encadenar transformaciones, por ejemplo
haciendo un crop como en el ejemplo anterior y aplicando un
filtro de color:

int color = Color.parseColor("#3300ff80");

Picasso
.with(this)
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224


https://github.com/wasabeef/picasso-transformations

.jpg")
.transform(new ColorFilterTransformation(color))
.transform(new CropCircleTransformation())
.into(imageView) ;

Cache Indicators y Logging

Cache Indicators

Picasso utiliza dos tipos de chache, memoria y almacenamiento.
En algunos casos, para comprobar y hacer tests de rendimiento
de nuestra aplicacién, nos interesara saber de donde se ha
obtenido la imagen. Para hacerlo debemos afadir la opcidn
.setIndicatorsEnabled(true)

Picasso

.with(this)

.setIndicatorsEnabled(true);
Picasso

.with(this)

.setIndicatorsEnabled(true);
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.into(imageView) ;

Una vez cargadas la imagenes estas tendrdn un indicador de
color en la parte superior izquierda. El esquema de colores
corresponde al origen del cual la imagen es:

= Verde (memoria, mejor rendimiento)

= Azul (memoria interna del dispositivo, rendimiento
medio)

= Rojo (red, el peor rendimiento)

Logging
Aveces necesitamos mas informacion que una simple indicacidén
del origen de 1la 1imagen. Utilizando 1la opcidn

.setLoggingEnabled(true); obtendremos en el 1log wuna
informacidén méds acurda del proceso creado por Picasso.



Picasso

.with(this)

.setLoggingEnabled(true);
Picasso

.with(this)

.setLoggingEnabled(true);
.load("http://www.guitarthai.com/picpost/gtpicpost/Q367224.jpg
")

.into(imageView) ;

Observaciones

Bien, hoy hemos tratado una libreria la cual conviene tener en
la caja de herramientas. Nos ofrece muchas opciones y nos
permite realizar operaciones de una manera muy simple. Como
contrapartida podemos decir que el rendimiento siempre se vera
afectado. Finalmente, dejo el enlace a la web de Picasso y un
simple ejemplo en Github.

= Picasso
= PicassoTest

Android — Parceler


http://adictosalainformatica.com/wp-content/uploads/2016/06/log.png
http://square.github.io/picasso/
https://github.com/rmiguel1985/PicassoTest
http://adictosalainformatica.com/android-parceler/

QY Parceler

Android Parcelable code generator for Google Android

oo

Introduccidn

Como se comento en el d4ltimo post de Java para android en
adelante trataremos librerias y ejemplos de novedades, para
cursos de android podéis encontrar enlaces en el post
anterior. En dicho post en la parte de serializacidn
comentabamos que en android existian parcelables y el porqué
debiamos utilizarlos. Bien pues hoy presentamos una libreria
que facilita mucho su uso Parceler

= Configuracion
= Utilizando Parceler en nuestra clase
= Observaciones

Configuracion

Para la instalacion, tenemos que afiadir el plugin android-apt
a nuestro classpath en el fichero build.gradle que se
encuentra en la raiz de nuestro proyecto.

dependencies{
classpath 'com.neenbedankt.gradle.plugins:android-apt:1.8"

}

Dentro del archivo app/build.gradle, debemos afiadir el plugin
antes de anadir las dependencias de Parceler.

plugin : 'com.neenbedankt.android-apt’

dependencies {
compile 'org.parceler:parceler-api:1.1.5"
apt 'org.parceler:parceler:1.1.5"


http://adictosalainformatica.com/wp-content/uploads/2016/05/parceler.png

Utilizando Parceler a nuestra clase

Incluiremos un constructor vacio, las variables de clase deben
ser public y finalmente utilizaremos 1la anotacién @Parcel.
Bien esto nos ahorra mucho cédigo y al mismo tiempo este se
hace mucho mds legible. Pero tiene un inconveniente, asume
como entorno toda la clase User. Para evitar encapsular
variables que no son necesaria utilizaremos 1la anotacidn
@Transient

@Parcel

public class User {
// class vars must be public
public String name;
public String lastName;
public String job;
@Transient
public boolean hasCar;

// empty constructor needed by the Parceler library
public User() {

}

public User(String name, String lastName, String job,
boolean hasCar) {
this.name = name;
this.lastName = lastName;
this.job = job;
this.hasCar = hasCar;

}

public String getName() {
return name,

}

public void setName(String name) {
this.name = name;



}

public String getLastName() {
return lastName;

}

public void setlLastName(String lastName) {
this.lastName = lastName;

}

public String getJob() {
return job;

}

public void setJob(String job) {
this.job = job;
}

public boolean isHasCar() {
return hasCar;

}

public void setHasCar(boolean hasCar) {
this.hasCar = hasCar;

}
}

Para crear un parcelable utilizaremos Parcels.wrap:

User user = new User("Joan", "Miquel", "Android Developer",
true);
Intent intent = new Intent(getApplicationContext(),
SecondActivity.class);

intent.putExtra("user", Parcels.wrap(user));

Para recuperar el objeto user utilizaremos Parcels.unwrap:

user = Parcels.unwrap(getIntent().getParcelableExtra("user"));

Observaciones



Como podéis comprobar el uso de esta libreria es muy (til y
ademas muy fdacil incluir en nuestros proyectos. Pero no todo
es perfecto, como toda libreria que utilicemos, mejorarda con
el tiempo y solucionara bugs. A priori esto es bueno pero no
disponemos de un sistema de upgrade automatico. Debemos de
estar detras de las novedades y preocuparnos notros de
actualizarla. Tenemos que tener en cuenta que utilizar esta
libreria tiene sus ventajas e inconvenientes. Nos facilita
mucho el uso de parcelabe pero al mismo tiempo es menos
eficiente que implementarlo nosotros mismos. De echo el uso de
esta libreria es un buen balance entre eficiencia y facilidad
de uso en comparacidén con una serializacidén y una
implementacidon de parcelabe. Cabe destacar que si nuestra
aplicacién requiere de la mdxima eficiencia lo mejor sera
implementar parcelable. A continuacidn os dejo el enlace a la
pagina de la libreria, un simple ejemplo en GitHub y un
articulo en android developers de como usar parcelables

= Parceler
= ParcelerTest
» Parcelable (Android Developer)

Curso de Java orientado a
Android - Parte 4
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Introduccidn

En este Ultimo post del curso de Java orientado a Android
trabajaremos un poco mas a fondo la programacidén orientada a
objetos y algunas particularidades propias de Java. Este va
ser el Ultimo post, de esta serie.

 Nested classes

= Beneficios de las inner classes
= Variables de clase (static)

= Funciones (static)

= Enumerated types

= Serialization

» Deserializing

Nested classes

En Java se puede definir una clase dentro de otra clase. Estas
se llaman «nested class»:

class OuterClass {
class NestedClass {

}



Las nested class pueden ser static:

class OuterClass {

static class StaticInnerClass {

}

class InnerClass {

}

Una nested class es miembra de su outer class. Las nested
clases no estaticas tienen acceso a otros miembros de la clase
externa, incluso si se declaran como private. Sin embargo, las
nested static clases no. De manera similar a las variables y
métodos miembros, una clase interna pueden ser declarados
privado, publico, protegido, o un paquete privado.

Beneficios de utilizar inner class

Las siguientes son algunas de las razones que tientan a un
programador para usar clases internas:

= Mejorar la agrupacion légica de clases que se utilizan
Unicamente en un solo lugar. Si una clase B es atil
solamente a otra clase A, entonces es ldgico que la
clase B sea una clase interna de la clase A.

- Aumentar la encapsulacion. Si la clase B necesita tener
acceso a los miembros privados de la clase A, un
programador puede ocultar la clase B dentro A y mantener
todos los miembros de la clase A como privados al mismo
tiempo que oculta la clase B del resto del entorno.

= Mejorar la legibilidad del coédigo y facilita el
mantenimiento. La creacién de las clases internas dentro
de una clase externa proporciona una organizacidén mas
clara de cd6digo.



Variables de clase (static)

Cuando creamos varios objetos de la misma clase, cada objeto
(instancia) tiene su propia copia de las variables miembro. A
veces, puede ser gue deseemos compartir una variable con todos
los objetos de 1la misma clase. Para lograr esto usamos
modificador static.

Las variables miembro que tienen el modificador static en su
declaracién se 1laman campos estaticos o variables de clase
staticas. Estan asociadas con la clase, en lugar de con
cualquier objeto. Cada instancia de la clase comparte una
variable de clase, que se guarda en una memoria fija.
Cualquier objeto puede cambiar el valor de una variable de
clase.

Vamos a modificar la clase de coches de la parte 2 de esta
serie de posts afadiendo una variable de clase static. La
variable numOfSeats puede tener valores diferentes para los
distintos objetos del tipo de coche. Sin embargo, podemos
anadir una variable de clase llamada numberOfCars que se
utilizard para realizar un seguimiento del numero de objetos
de coches creados.

public class Car extends Vehicle {
public int numOfSeats;
//A class variable for the
//number of Car objects created
public static int numberOfCars;

}

Las variables de clase son referenciadas por el propio nombre
de la clase:

Car.numberOfCars;

Funciones de clase (static)



Java también soporta métodos estaticos, estos tienen el
modificador static en su firma. Un uso comin de los métodos
estaticos es tener acceso a los campos estaticos. Por ejemplo,
vamos a modificar la clase de coche mediante la adicidén de un
método estatico que devuelve la variable statica numOfCars:

public static int getNumberOfCars() {
return numberOfCars;

}

Enumerated types

Un enumerated type (también 1llamado enumeration o enum) es un
tipo de datos que consiste en un conjunto de constantes
Lllamadas elementos. Un ejemplo comin de enumeracidén es 1los
dias de la semana. Dado que son constantes, los nombres de los
campos de un enum estan en letras mayusculas.

Para definir un tipo de enum en Java, utilizamos la palabra
clave enum. Por ejemplo, el siguiente tipo de
enumeracion define un conjunto de enumeraciones para las
versiones de Android:

public enum androidVersionCodes {
CUPCAKE, DONUT,ECLAIR,FROYO,
GINGERBREAD,HONEYCOMB,ICE CREAM SANDWICH,
JELLY BEAN,KITKAT,LOLLIPOP,MARSHMALLOW

}

Los enum se deben utilizar siempre que se necesite representar
un conjunto fijo de constantes.

Serialization

La serializacidén es el proceso de convertir un objeto en un
formato que puede ser almacenado y luego convertido de nuevo
mas tarde a un objeto en el mismo o en otro entorno
informatico.

Java proporciona serializacién automdtica, para tulizarla el



objeto debe implementar la interfaz java.io.Serializable
Java entonces maneja serializacidén internamente.

La siguiente es una clase Java que almazena una versidn de
android (nombre y codigo de versién). Es serializable, y tiene
dos variables miembro: androidVersionName y
androidVersionCode.

import java.io.Serializable;

public class AndroidVersions implements Serializable {
private Double androidVersionCode;
private String androidVersionName;

public Double getAndroidVersionCode () {
return androidVersionCode;

}

public void setAndroidVersionCode(Double
androidVersionCode) {
this.androidVersionCode = androidVersionCode;

}

public String getAndroidVersionNmae() {
return getAndroidVersionNmae;

}

public void setAndroidVersionName(String
getAndroidVersionNmae) {
this.getAndroidVersionNmae = getAndroidVersionNmae;

}
}

Ahora que tenemos un objeto serializable, podemos hacer una
prueba del proceso de serializacidn escribiendo un objeto en
un fichero. E1l siguiente cédigo escribe un objeto
AndroidVersions en un fichero 1llamado android.ser:

import java.io.FileOutputStream;
import java.io.IOException;
import java.io.ObjectOutputStream;



import java.util.ArraylList;
public class SerializeAndroidVersions {

public static void main(String[] args) {

AndroidVersions andVersions = new AndroidVersions();

andVersions.setName("Jelly Bean");
andVersions.setAndroidVersionCode(4.1);

try
{
FileOutputStream fileOut
FileOutputStream("/home/user name/android.ser");
ObjectOutputStream out
ObjectOutputStream(fileOut);
out.writeObject(e);
System.out.println("Serialized...");
out.close();
fileOut.close();
}
catch (IOException 1) {
i.printStackTrace();

}

= hew

= new

Como resultado tendremosun fichero android.ser en nuestra

carpeta de usuario.

Deserializing

Ahora podemos crear un objeto a partir del fichero guardado
en disco. Lo uUnico que debemos hace es acceder al fichero y

convertirlo en un objeto.

El siguiente ejemplo muestra como realizar este proceso:

import java.io.FileInputStream;
import java.io.IOException;
import java.io.0ObjectInputStream;



import java.util.ArraylList;

public class DeserializeAndroidVersions {
@SuppressWarnings (
"unchecked"

)

public static void main(String[] args) {
AndroidVersions androidVersions = new AndroidVersions();
try{
FileInputStream fileln = new
FileInputStream("/home/ user name/android.ser");
ObjectInputStream in = new ObjectInputStream(fileln);
androidVersions = (AndroidVersions) in.readObject();
in.close();
fileIn.close();

Ycatch (IOException i) {
return;

}catch ClassNotFoundException c) {
System.out.println("AndroidVersions class not found.");
c.printStackTrace();
return;

}

if(androidVersion instanceof AndroidVersions) {
System.out.println("----------------------- ")
System.out.println("Deserialized AndroidVersions
object...");

System.out.println("Name: " +
androidVersions.getAndroidVersionNmae());
System.out.println("Code version: " +
androidVersions.getAndroidVersionCode());
System.out.println("----------------------- ")

}
}
}

Ejecutando el coédigo anterior obtendremos el siguiente
resultado:

Deserialized AndroidVersions object...



Name: Jelly Bean
Code version: 4.1

Llegados a este punto ahora entendemos la ldgica de 1la
serializacién. Esta bien a nivel conceptual, de aprendizaje,
pese a ello este procedimiento no es el usual en Android.
Podemos utilizar la serializacién, pero en vez de ello
utilizaremos Parcelable. En este articulo se explica el porqué
debemos utilizar parcelabes.

Observaciones

Con este post damos por terminada la introduccién a 1la
programacién en Java para Android. La idea era realizar un
curso de Android una vez finalizada esta serie, pero no va a
ser asi. Des de que empezdé la serie hasta ahora viendo como se
esta desarrollando el entorno Android he optado por no
hacerlo. Me centraré ejemplos concretos y en librerias.
Exsisten muschas y ayudan muchissimo en el dia a dia de la
programacion en Android. Tareas que a priori pueden parecer

muy complicadas o introducir excesivo codigo nos las
facilitan. No por eso voy a hacer el salto sin mas, partiendo
de lo aprendido anteriormente, a continuacién dejo tres muy
buenos recursos para aprender Android:

= Android Official Training (Inglés)
= Vogella tutorials (Inglés)
= Sgoliver curso Android (Castellano)



http://www.developerphil.com/parcelable-vs-serializable/
http://www.sgoliver.net/blog/curso-de-programacion-android/indice-de-contenidos/#
http://www.vogella.com/tutorials/android.html
http://www.sgoliver.net/blog/curso-de-programacion-android/indice-de-contenidos/#
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Introduccidn

Después de cubrir los conceptos basicos de los principios de
la programacién orientada a objetos en el post anterior, ahora
atenderemos a otros conceptos que nos encontraremos a la hora
de programar en Java. Exactamente como tratar la gestién de
errores y colecciones de informacidn.

» Exceptions
= Java Collections
= Interfaces
= Implementations
 ArrayList
» HashSet
» HashMap

Exceptions


http://adictosalainformatica.com/curso-de-java-orientado-a-android-parte-3/
http://adictosalainformatica.com/curso-de-java-orientado-a-android-parte-3/

La gestidén de errores es una parte esencial para asegurar un
cdédigo robusto. Java utiliza excepciones para manejar errores.

Cuando se produce un error, el entorno de ejecucién de Java
maneja un objeto de error que se crea por el método en el que
se produce el error. Este objeto se 1llama excepcién, vy
contiene informacidén basica sobre el error (como el tipo de
error, la ubicacidén, la pila de los métodos que conducen al
error .. etc.).

La lista de los métodos que conducen al error se le llama call
stack (pila de llamadas). Al manejar el error, el sistema
busca a través de esa pila un controlador de errores en el
cédigo; es decir, un controlador de excepciones. Todos 1los
objetos de excepcidén son los hijos de la clase padre
Exception.

Las Excepciones en Java se pueden clasificar en dos tipos:

Categoria Descripciodn

Estos son errores dentro de cédigo de la aplicacién. Un
programador que tiene la intencidén de crear un cédigo
bien escrito y robusto debe poder recuperar el programa
de estos errores. Por ejemplo, leyendo un archivo en
disco, un programador debe tener en cuenta que el
fichero quizas no exista. En este caso, el programador
debe esperar una excepcién del tipo
java.io.FileNotFoundException. Debera, enconces,
capturar para notificar al usuario de lo que ha ocurrido
de una forma correcta y controlada sin detener la
ejecucién del programa.

Excepcidn
controlada




Estos vienen en dos tipos: los propios errores y tiempo
de ejecucidnexcepciones. Se agrupan en una categoria
porque ambosno es posible anticipar o recuperarse de un
programador.Los errores son externos a las aplicaciones.
Por ejemplo, supongamosque una aplicacién abre
correctamente un archivo para la entrada, pero es no

Excepcién puede leer el archivo debido a un hardware o del
no sistemaFuncionamiento defectuoso. La lectura infructuosa
controlada arrojarajava.io.IOError, y tiene sentido para que el

programaimprimir un seguimiento de pila y salir. Los
errores son esas excepciones de tipoClase de fallo y sus
subclases.Excepciones de tiempo de ejecucién
generalmente indican errores de programacién, como
errores légicos. Son o una clase de tipo
RuntimeException ysus subclases.

La gestidn de errores (excepciones) en Java se realiza a
través de los bloques try-catch-finally . Mientras que la
bloque finally es opcional, los bloques try y catch son
obligatorios para cumplir con el tratamiento de errores.

Veamos el siguiente cédigo:

public class ExceptionTest {
public static void main(String[] args) {
System.out.println("Hello World
adictosalainformatica!");
String nullString = null;
System.out.println("Entered try statement");
String partialString =
nullString.substring(1l);
// Execution will break before reaching this
line
System.out.println("Partial string is: " +
partialString);
}
}

El resultado de ejecutar el cdédigo sera un error del tipo
NullPointerException, en concreto en la linea 6, donde estamos
tratando de leer de un objeto de cadena que es nulo (no
inicializado) Para manejar adecuadamente este error, debemos
modificar el cdédigo anterior de la siguiente manera:



public class ExceptionTest {
public static void main(String[] args) {
System.out.println("Hello World
adictosalainformatica!");
String nullString = null;
try {
System.out.println("Entered try
statement");
String partialString =
nullString.substring(1l);
// Execution will continue in the
exception block
System.out.println("Partial string is:
"+partialString);
} catch (Exception e) {
System.out.println("Error occured:
"+e.getMessage());
e.printStackTrace();

}
}

En vez de romper la ejecucidn de cdédigo y detener el programa,
este cédigo se encargara de manejar la excepcidn
NullPointerException mediante la impresién de los detalles del
error y continuando la ejecucidén mas alla de la bloque catch.
El bloque finally se puede utilizar después del bloque de
excepcion. Este bloque de cdédigo se ejecutara siempre, tanto
si se lanza una excepcidén como no.

try {
System.out.println("Entered try statement");

String partialString = nullString.substring(1l);
// Execution will break before reaching this line
System.out.println("Partial string is: " +
partialString);
} catch (Exception e) {
System.out.println("Error occured: "+e.getMessage());
e.printStackTrace();
} finally {
System.out.println("This line of code will always



run!");

}

En muchos casos utilizamos el bloque finally cuando hay
algunos recursos que necesitan ser liberados. Es posible que
después de una excepcioén no lo esto no ocurra porque el cédigo
que deberia hacerlo no es ejecutado. Por ejemplo, un programa
que lee un fichero, este debe cerrar el archivo después de
terminar la lectura y/o escritura. Si una excepcidén es
lanzada, la linea de cddigo que cierra el archivo puede ser
omitida. El bloque finally seria el mejor lugar donde cerrar
el fichero.

Java Collections

Java proporciona un conjunto de clases e interfaces para
ayudar a los desarrolladores manejar colecciones de objetos.
Esta coleccidén de clases sén similiares a un array, excepto
por su tamafno (puede crecer de forma dinamica durante tiempo
de ejecucion). En esta seccidn se ofrecera una visidn general
de algunas de las clases de Java collection mas populares.

Interfaces

Las Java Collections se encuentran principalmente en el
paquete java.util. Proporciona dos interfaces principales:
Collection y Map. Estas dos forman el nulUcleo del Java
Collection framework. Otras interfaces heredan de estas dos.
Por ejemplo, las interfaces List y Set heredan de la interfaz
Collection. Todas estas interfaces son genéricas; es decir, el
tipo de objeto contenido en la coleccidén debe ser especificado
por el programador. Hay una diferencia fundamental entre las
subclases de la interfaz Collection y de la interfaz Map:

= Collection contiene un grupo de objetos que pueden ser
manipulados y traspasados. Los elementos pueden ser



duplicados o uUnicos, dependiendo del tipo de sub-clase.
Por ejemplo, Set solo contiene objetos Unicos.

»La interfaz Map, sin embargo, mapea los valores a los
ids (keys) y no puede contener keys duplicadas y a cada
una s6lo se le puede asignar un valor

Implementations

Las implementaciones son los objetos de datos que se utilizan
para almacenar colecciones, que implementan las interfaces de
la seccidon anterior. A continuacién se explican 1las
siguientes implementaciones:

ArraylList

Un ArrayList es una implementacidén de array redimensionable de
la interfaz List. Implementa todas las operaciones opcionales
de lista y permite todo tipo de elementos, incluyendo null.
También proporciona métodos para manipular el tamano del array
que se utiliza internamente para almacenar la lista.

import java.util.*;

class TestArrayList {
public static void main(String args[]) {
// Creating an array list
ArrayList androids = new ArraylList();
// Adding elements
androids.add("Cupcake");
androids.add("Donut");
androids.add("Eclair");
androids.add("Froyo");
androids.add("Gingerbread");
androids.add("Honeycomb");
androids.add("Ice Cream Sandwich");
androids.add("Jelly Bean");
System.out.println("Size of ArrayList: " +
androids.size());
// Display the contents of the array list
System.out.println("The ArraylList has the
following elements: "



+ androids);
// Remove elements from the array list
System.out.println("Deleting second

element...");

androids.remove(3);

System.out.println("Size after deletions: " +
androids.size());

System.out.println("Contents after deletions:
" + androids);

}

}

ELl resultado sera:

Size of ArraylList: 8

The ArrayList has the following elements: [Cupcake, Donut,
Eclair, Froyo,

Gingerbread, Honeycomb, Ice Cream Sandwich, Jelly Bean]
Deleting second element...

Size after deletions: 7

Contents after deletions: [Cupcake, Donut, Eclair,
Gingerbread, Honeycomb,

Ice Cream Sandwich, Jelly Bean]

HashSet

Esta clase implementa la interfaz Set y permite el elementos
null. Esta coleccién no permite duplicados. Crea una coleccién
que utiliza una tabla hash para el almacenamiento. Una tabla
almacena informaciéon de hash mediante el uso de un mecanismo
Llamado hashing donde se utiliza el valor almacenado para
determinar una clave Unica, que se utiliza como el indice en
el que los datos se almacenan. La ventaja del hashing es que
permite tiempos de ejecucidn rapidos para operaciones basicas,
como add() y remove().

class TestHashSet {
public static void main(String args[]) {
// Creating a HashSet
HashSet androids = new HashSet();
// Adding elements



’

androids.add("Cupcake");
androids.add("Cupcake")
androids.add("Eclair");
androids.add("Eclair");
androids.add("Gingerbread");
androids.add("Honeycomb");
androids.add("Ice Cream Sandwich");
androids.add("Jelly Bean");

System.out.println("The contents of the
HashSet: " + androids);
}
}

ELl resultado sera:

The contents of the HashSet: [Eclair, Cupcake, Honeycomb, Ice
Cream Sandwich, Jelly Bean, Gingerbread]

Como podemos comprobar solo hay un elemento “Cupcake” y uno
“Eclair” aunque en el cédigo los hayamos afladido dos veces.

HashMap

Esta es una hashtable basada en 1la implementacidén de la
interface Map. Los elementos introducidos no tendran un orden
especifico y permite elementos null.

El siguiente programa muestra un ejemplo de HashMap. Se
asignan nombres para contabilizar saldos.

import java.util.*;
class TestHashMap {
public static void main(String args[]) {
// Creating a HashMap
HashMap<String,Double> androids = new
HashMap<String,Double>();
// Adding elements



Double(4.0));

androids.put("Cupcake", new Double(1l.5) );
androids.put("Donut",new Double(1.6));
androids.put("Eclair", new Double(2.1));
androids.put("Froyo", new Double(2.2));
androids.put("Gingerbread", new Double(2.3));
androids.put("Honeycomb", new Double(3.1));
androids.put("Ice Cream Sandwich", new

androids.put("Jelly Bean", new Double(4.1));
// Get a set of the entries
Set<Map.Entry<String, Double>> set =

androids.entrySet();

// Get an iterator
Iterator<Map.Entry<String, Double>> i

set.iterator();

// Display elements

while (i.hasNext()) {

Map.Entry<String, Double> me =

(Map.Entry<String,Double>)

0.1));

Eclair: "

}

1.next();
System.out.print(me.getKey() + ": ");
System.out.println(me.getValue());

}

System.out.println();

// Increase version number of Eclair

Double version = androids.get("Eclair");

androids.put("Eclair", new Double(version +

System.out.println("New version number of

+ androids.get("Eclair"));

El resultado sera:

Eclair: 2.1
Cupcake: 1.5
Honeycomb: 3.1
Froyo: 2.2
Donut: 1.6

Ice Cream Sandwich: 4.0



Jelly Bean: 4.1
Gingerbread: 2.3
New version number of Eclair: 2.2

Observaciones

En este tercer post hemos mostrado el manejo de excepciones y
la utilizacidon de Collections. Se ha mostrado una parte
especifica y concreta, seria recomendable profundizar un poco
mas en estos conceptos dado que, aqui solo se muestran
conceptos basicos.

= Oracle Exception tutorial
= Oracle Collections tutorial

Curso de Java orientado a
Android - Parte 2

Javaf;rn;:ouv

Introduccion

Java es un lenguaje de programacion orientado a objetos (OOP).
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En este post cubriremos las caracteristicas y principios
basicos de la programacién orientada a objetos proporcionando
algunos ejemplos de cédigo. Este post puede completarse con
los siguientes: Pincipios de programacién orientada a

objetos y Principios del diseifo de clases

= Objects

= Classes

= Getters y Setters

= Inheritance

= Keywords this y super

= Interface

= Access Modifiers

= Contructors

» Method overriding and overloading
= Polymorphism

Objects

Un objeto es un conjunto de software de estado y el
comportamiento relacionado en memoria. Normalmente se utilizan
para representar objetos del mundo real. Los objetos son
esenciales para la comprensién OOP. Los objetos del mundo real
comparten dos caracteristicas: estado y el comportamiento.
Por ejemplo, un coche tiene un estado (modelo actual ,
fabricante, color) y el comportamiento (conduccién, cambio de
marchas ..)

El desarrollo de aplicaciones con cédigo orientado a objetos
aporta muchos beneficios, incluyendo coédigo de facil
reutilizacién, ocultacién de informacién, facilidad de
depuracion..

Classes


http://adictosalainformatica.com/?p=670
http://adictosalainformatica.com/?p=670
http://adictosalainformatica.com/?p=665

Una clase es un prototipo a partir de la cual se crean los
objetos. En ella se definen los modelos — estado y el
comportamiento de un objeto del mundo real. Las clases
proporcionan una forma limpia para modelar el estado vy
comportamiento de los objetos del mundo real. Podemos
distinguir dos propiedades, o secciones, principales a definir
en una clase:

= Un conjunto de variables de clase (también 1lamadas
campos)
= Un conjunto de métodos de clase (o funciones).

Para representar el estado de un objeto en clases tenemos las
variables de clase. Los comportamientos de 1los objetos
son representados usando métodos. La siguiente es una sencilla
clase Java llamada de vehiculo.

class Vehicle {
int speed = 0;
int gear = 1;
void changeGear(int newGear) {
gear = newGear;
}
void speedUp(int increment) {
speed = speed + increment;
}
void printStates() {
System.out.println(" speed:" + speed + "
gear:" + gear);
}
}

El estado del objeto Vehiculo se representa con la velocidad
(speed) y las marchas (gear). El comportamiento del objeto se
puede cambiar utilizando los dos métodos ChangeGear() vy
speedUp(). Por uUltimo podemos saber cual es el estado actual
con el método printStates()



Getters y Setters

Un conjunto de métodos se crean por lo general en una clase
para leer/escribir los valores de las variables miembro
Estos son 1llamados getters(se utiliza para obtener 1los
valores) y setters(se utiliza para cambiar la valores de
variables miembro).

Los Getters y Setters son cruciales en las clases de Java, ya
que se utilizan para gestionar el estado de un objeto. En 1la
clase vehiculo que hemos visto anteriormente, podemos afadir
dos métodos (un getter y un setter) para cada variable
miembro. El siguiente es el cdédigo completa la clase anteriror
con los getters y setters correspondientes a la variables
miembro speed y gear:

class Vehicle {
int speed = 0;
int gear = 1;
// Start of getters and setters
public int getSpeed() {
return speed;

}

public void setSpeed(int s) {
speed = s;

}

public int getGear() {
return gear;

}

public void setGear(int g) {
gear = ¢,

}

// End of getters and setters

void changeGear(int newGear) {
gear = newGear;

}

void speedUp(int increment) {
speed = speed + increment;

}
void printStates() {



System.out.println(" speed:" + speed + "
gear:" + gear);
}
}

Inheritance

La herencia proporciona un mecanismo poderoso y natural para
la organizacidén y estructuracién del software. Se establece
una relacidn padre-hijo entre dos objetos diferentes.

La programacién orientada a objetos permite que 1las
clases hereden estado y comportamiento de uso comin de otras
clases. En siguiente ejemplo, vehiculo (Vehicle) se convierte
en la clase padre (superclass) de camiones (Truck) y coches
(Car). En el lenguaje de programacidén Java, permite que cada
clase tenga una superclase directa, y cada superclase puede
ser heredada por un numero ilomitado de subclases.

public class Car extends Vehicle {
int numOfSeats;
//Set of statements defining
//a car’s state and behavior

}

public class Truck extends Vehicle {
public int loadWeight;
//Set of statements defining
//a truck’s state and behavior

}

Ahora 1la clase Truck y Car comparten el estado vy
comportamiento de la clase Vehicle.

Keywords this y super

Dos palabras clave de Java que se puede encontrar al escribir
que el cédigo de clase con la herencia: this y super. La



palabra clave this se utiliza como una referencia a la clase
actual, mientras que super es una referencia a la clase padre
que esta clase ha heredado. En otras palabras, super se
utiliza para acceders a las variables y métodos miembro de la
clase padre.

La palabra reservada super es especialmente Util cuando se
desea reemplazar el método de la superclase en la clase hijo,
pero se desea invocar el método de la superclase. Por ejemplo,
en la clase de Car, se puede sobrescribir el método
printStates() y a su vez llamar al método printStates de la
clase Vehicle ():

public class Car extends Vehicle {
int numOfSeats;
void printStates() {
super .printStates();
System.out.println(

Number of Seats:" +
numOfSeat) ;

}
}

Llamando al método printStates() de la clase Car se invocara
primero printStates() de la clase Vehicle y posteriormente se
mostrara el resultado de println.

Interface

Una interfaz es un contrato entre una clase y el mundo
exterior. Cuando una clase implementa una interfaz, debe
proporcionar el comportamiento especificado por esa interfaz.
Tomando el ejemplo de Vehicle crearemos una interfaz.

public interface IVehicle {
void changeGear(int newValue);
void speedUp(int increment);

}

Ahora la clase Vehicle implementa la interfaz IVehicle
utilizando la sintaxis siguiente:



class Vehicle implements IVehicle {
int speed = 0;
int gear = 1;
public void changeGear(int newValue) {
gear = newValue;
}
public void speedUp(int increment) {
speed = speed + increment;
}
void printStates() {
System.out.println(" speed:" + speed + "
gear:" + gear);
}
}

Se debe tener en cuenta que la clase de Vehicle debe
proporcionar y la implementacién de métodos los métodos
changeGear() y speedUp().

Access Modifiers

Los modificadores de acceso determinan si otras clases pueden
utilizar una variable o invocar un método en concreto. Hay
cuatro tipos de control de acceso:

A nivel de clase — public o default (sin modificador
explicito).

A nivel de miembro de clase (variable o método)
— public, private, protected o default (sin modificador
explicito).

Una clase puede ser declarada como publica con el modificador
public, en cuyo caso esa clase es visible para todas las
clases en todas partes. Si una clase no tiene modificador (por
defecto), es visible sélo dentro de su propio package (un
package es una agrupacién de clases afines).

A nivel de miembro, ademds los modificadores public o default
(package-private), existen dos modificadores de acceso



adicionales: private y protected. El modificador private
especifica que el miembro sdélo puede ser accedido des de su
propia clase. El modificador protected especifica se puede
acceder al miembro dentro de su propio package y, ademas, por
cualquier otra subclase de de esta.

Access Levels

Modifier | Class | Package | Subclass | Al10ther

public

protected

Default

private

Contructors

Los constructores se invocan para crear objetos. Son similares
a las funciones, pero diferenciadas por la siguiendo:

» Los constructores tienen el mismo nombre que la clase
 No tienen ningun tipo de retorno.

Llamar a un constructor para crear un nuevo objeto seria
inicializar miembros de un objeto. suponer El vehiculo tiene
el siguiente constructor:

public Vehicle(int speed, int gear){
this.speed = speed;
this.gear = gear;

}

Para crear un nuevo objeto de la clase Vehicle invocando el
constructor deberemos utilizar la palabra reservada new:

Vehicle vehicle = new Vehicle(4, 2);

Esto creara un nuevo objeto de la clase Vehicle con sus dos



variables de clase speed y gear inicializadas a 4 y 2.

Method overriding and overloading

Dentro de la misma clase, se pueden crear dos métodos con el
mismo nombre pero se diferencia en el nuUmero de argumentos y
sus tipos. Esto se llama sobrecarga de métodos.

La sobrecarga de métodos ocurre cuando una clase hereda un
método de una super clase, pero ofrece su propia aplicacién de
ese método. En el siguiente cédigo, la clase Car sobrecarga el
método SpeedUp() definido en la clase de Vehicle.

public class Car extends Vehicle {
int numOfSeats;
public void speedUp(int increment) {
speed = speed + increment + 2;
}
}

Supongamos que creamos un objeto de tipo Car y llamamos al
método 1llamé a la speedUp(). Entonces, el método del Vehicle
es ignorado y se ejecuta el de la clase Car:

Car car = new Car();
car.speedUp(2);

Polymorphism

En el contexto de la programacidén orientada a objetos, el
polimorfismo significa que las diferentes subclases de la
misma clase padre puede tener comportamientos diferentes, pero
comparten algunas de las funcionalidades de la clase padre.
Para demostrar el polimorfismo, afadiremos el método showInfo
() a la clase de Vehicle. Este método imprime toda la
informacién en un objeto del tipo de Vehicle:

public void showInfo() {
System.out.println("The vehicle has a speed of: " +



this.speed
+ " and at gear " + this.gear);

}

Sin embargo, si la subclase Truck utiliza este método, la
variable miembro loadWeight no sera imprimida, ya que no es un
miembro de la clase padre Vehicle. Para resolver esto, podemos
sobreescrivir el método showInfo() de la siguiente manera:

public void showInfo() {
super.showInfo();
System.out.println("The truck has is carrying a load
of: "
+ this.loadWeight);
}

Podemos observar que el método showInfo() de Truck, 1lamara
showInfo() de la clase padre y agregar a ella su propio
comportamiento — el cual imprime el valor de loadWeight.
Podemos hacer 1o mismo con la clase Car.

public void showInfo() {
super.showInfo();
System.out.println("The car has "
+ this.numOfSeats + " seats.");

}

Ahora, podemos hacer un test de polimorfismo. Crearemos 3
objetos, cada uno de un tipo de Vehicle diferente

class TestPolymorphism {
public static void main(String[] args) {

Vehicle vehiclel, vehicle2, vehicle3;
vehiclel = new Vehicle(50,2);
vehicle2 new Car(50,2,4);
vehicle3 = new Truck(40,2,500);
System.out.println("Vehicle 1 info:");
vehiclel.showInfo();
System.out.println("\nVehicle 2 info:");
vehicle2.showInfo();
System.out.println("\nVehicle 3 info:");
vehicle3.showInfo();



}

El resultado de ejecutar esta clase serd la creacidén de tres
tipos de objeto diferentes:

Vehicle 1 info:

The vehicle has a speed of: 50 and at gear 2
Vehicle 2 info:

The vehicle has a speed of: 50 and at gear 2
The car has 4 seats.

Vehicle 3 info:

The vehicle has a speed of: 40 and at gear 2
The truck has is carrying a load of: 500

En el ejemplo anterior, la JVM ha llamado el método de cada
objeto en lugar de llamar el objeto de Vehicle.

Observaciones

En este segundo post hemos introducido varios conceptos de
programacién orientada a objetos enfocada al entorno Java.
Esta parte es muy importante, se debe tener en cuenta que un
correcto disefio nos va asegurar en el futuro un facil
mantenimiento del cdédigo. Bien porqué tengamos que afnadir
funcionalidades o porqué debemos solucionar bugs. Esta parte a
nivel tedrico se puede ampliar con los siguientes posts:

» Pincipios de programacion orientada a objetos
 Principios del disefio de clases
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